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Welcome to InDesign CS6!  InDesign is a powerful application for creating print layouts.  It is the primary applica-

tion that you will use to produce the actual pages of  your yearbook.  If  you have used InDesign before, pay close 

attention to the features marked with a CS6 symbol, which indicates new or significantly changed features in the 

CS6 version of  InDesign.

InDesign is a complex program, but there is no need to learn every aspect right away.  It is designed with ease-of-use 

in mind, and you can learn new features as you gain more and more experience.

Nearly every operation in InDesign can be performed in several different ways (by selecting from a menu, by pressing 

a keyboard shortcut, by using a toolbar or panel).  We will cover some of  the most convenient ways of  working in 

this guide, but you may prefer to work in a different way.  InDesign was thoughtfully designed so that every designer 

can use it in the way she or he is most comfortable.



GettinG Started with indeSiGn CS6 · 3

The Workspace
InDesign uses a combination of  different windows, toolbars, and panels that together form the workspace.

The workspace is highly customizable, by dragging the different elements around the screen.  You can even “dock” panels 
together or “dock” them to the edges of  the screen.  You can save your favorite workspace arrangements and switch 
between them in the window > workSPaCe menu.

Adobe provides several pre-made workspaces in the window > workSPaCe menu, and the [eSSentialS] workspace is 
shown below.  The [eSSentialS] workspace is a good starting place for the work that needs to be done to create the 
yearbook.

document Split View button

Margin
Pasteboard

Page

bleed

toolbar

Panels

Control bar application Frame

 Click this button to split the 
window into two separate 
views, so that you can view two 
parts of  the same document 
simultaneously.

CS6
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Alter the gaps between objects U   Gap tool

Change how a gradient flows G   Gradient Swatch tool

Move the page around within the window h   hand tool
Zoom in or out of  the page view Z   Zoom tool

 Shift+G   Gradient Feather tool
Make an object fade away in one direction

 Set the color of  fills and 
outlines for objects and text

 Swap fill color and outline color

 Current fill color

 Current stroke (outline) color

 Set the fill and stroke to defaults

 Select fill and stroke for frame

 Select fill and stroke for text

 Switch between selecting fill and stroke

line tool \   Draw Straight lines

Draw shapes point-to-point P   Pen tool

Draw an empty frame F   rectangle Frame tool

Applies last selected solid color ,   apply Color
Applies last selected gradient .   apply Gradient
Clear all color - make transparent /   apply none

Toggle view modes w   Change View Mode

Draw an empty frame  ellipse Frame tool
Draw an empty frame  Polygon Frame tool

Toolbar basics

Selection tool  V  esc  Select objects

type tool  t  Select or edit text

Pencil tool  n  Draw a line freehand

rectangle tool  M  Draw a filled rectangle

Free transform tool  e  Rotate, scale, or shear

rotate tool  r  Rotate an object

Scale tool  S  Scale an object

Shear tool  o  Shear an object

ellipse tool  l  Draw a filled ellipse

Fill/outline Settings

Polygon tool  Draw a filled polygon

type on a Path tool Shift+t   Select and edit 
text on an unusual shape

direct Selection tool  a  Select content or 
edit frame shapes 

X

The toolbar provides a large number of  tools for working with documents.  Here is a look at the primary tools to be aware 
of  when starting out.  The most-frequently used are highlighted in yellow.  For a full guide to all of  the tools, see page 39.

The tools can be selected by clicking them, or by typing the shortcuts indicated like this  on the keyboard any time you 
are not editing text. Tools with a dark mark in the lower right corner have other, related tools available in a sub-menu.  
Click and hold to see the submenu, and select a tool. To select the tool currently shown on the main toolbar, just click once.

CS6

w

*for a look at all of the tools, see page 39.
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When working with InDesign, it is often handy to keep one hand on the mouse (or trackpad), and the other on 
the keyboard.  The scrolling function on your trackpad/mouse or scroll wheel on your mouse can be used to 
quickly navigate around your InDesign document.

NavigaTioN shorTcuTs

Zoom using the scrolling function with the option  key held down.

move your view using the scrolling function with no keys held down.

Apple’s Magic Mouse and most trackpads can be used to scroll in any direction.

Jump to full-page view by pressing Command+0  (on Mac) or Ctrl+0  (on Windows)

Tip! Click and hold down your mouse or trackpad button for a moment before moving or resizing to see a preview 
of  the final result as you move or resize.  In CS5 or above, this effect can be set without a delay in the PreFerenCeS, 
under interFaCe - liVe SCreen drawinG.  Be careful!  Setting no delay can slow down your computer’s performance 
— the delayed option lets you use the Live Screen Drawing only when needed, as in previous versions of  InDesign.
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Tip! Double-clicking the bottom handles of  a text box will cause InDesign to resize the text box to fit the text exactly.

TexT Frames contain text of  any sort — headlines, stories, or more.  They can have 
text in one column, or multiple columns. Empty text frames have no ‘X’ 
through them, and have two extra handles: the entry point and the exit 
point.

Itatquostet 
maio. Namus 
repellum et 
volorem dolorep 
erferovidus et 
qui quo que 
nonsectur? Sum 
volor am aborum 
volorum et id 
maiorer estrunt.

Nempor sam, 
corum facearc 
hitiasp ieturitem 
solor as sunti 
raecesc imilles 
torumquae re 
aligent alis pa 
apienda ndanist 
iaspellaut fugit 
idusaest, culliquia 
autas esequis 

dolorer uptaspi-
scim quam quo 
quatat.

Ibusame 
volestotati debis 
doluptiaSolorum 
vollesequi 
dolorror aspedit 
et que comnisi 
conseque dolutem 
olore, corem 

handles

edit corner shapes

exit Point

entry Point

Handles allow you to resize the frame. Drag 
the middle handle on a side to change the 
shape only in that one dimension; drag a 
corner handle to change both dimensions 

simultaneously.  Hold Command+Shift  
(on Mac) or Ctrl+Shift  (on Windows) 
to resize both the frame and its content 
proportionally.

Clicking this special handle changes the 
corner handles to yellow diamonds, which 
can be used to round or shape the corners.

Frames
Every item on your page is either contained by a frame or is a frame itself.  Most frames are not visible when a document 
is printed, but every bit of  text and every image is contained within one.  Mastering frames is essential to working with 
layouts in InDesign.

graphics Frames can contain images, or they can simply be filled and outlined 
to be printed as an object.  Empty graphics frames have an ‘X’ 
drawn through them.
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When working with both graphics and text, you can choose to select and edit either the frame or the contents of  
the frame.  For example, to crop a photo, you might choose to shrink the size of  the frame, but keep the content 
(the photo) the same size.  You might also choose to center the photo within the frame, while leaving the overall 
item at the same place on the page.  The two arrows in InDesign help you to manipulate each:

makiNg selecTioNs

Tip! Hold Command+Shift  (on Mac) or Ctrl+Shift  (on Windows) to resize both the frame and its content 

proportionally.  Hold down option  (on Mac) or alt  (on Windows) to resize from the center.

selecTioN arroW
This arrow selects the frame.  Moving the frame moves the 
entire object — the frame and its content.  Resizing the frame 
does not affect graphics content unless you are holding down  

Command  (on Mac) or Ctrl  (on Windows).  Resizing text frames will 
cause the text to re-flow within the frame. Holding Command  (on Mac) or 

Ctrl  (on Windows) while resizing a text frame will resize the text as well, 
instead of  re-flowing it.

DirecT selecTioN arroW
This arrow selects contents of a frame.  When clicking on the 
contents of  a graphics frame, a new outline and set of  handles 
will appear (brown in your first layer), showing you the bound-
aries of  the graphic, even if  they extend outside of  the of  the 
frame.  Use these handles to change the size, shape and posi-
tion of  the graphic within the frame.
imporTaNT! Make sure that if  you are dragging the handles of  a photo, you 
hold down the Shift  key on the keyboard to keep it in proportion. Other-
wise, the photo will become distorted.

coNTeNT grabber
When you roll over a graphics frame with your cursor (don’t 
click), you will see a translucent target appear. This is the 
Content Grabber. Click this target to switch to selecting and 
manipulating the content of  the frame without having to switch 
to the white direct selection arrow.  This will cause the brown boundaries and 
handles to appear, so that you can manipulate the graphic.
imporTaNT! Don’t forget that just as with the direct selection arrow, if  you 
are dragging the handles of  a photo, you must hold down the Shift   key on 
the keyboard to keep it in proportion and avoid a distorted photo.

 V  
or

 esc  

a
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Getting your document setup correctly at the beginning can help cut time having to re-adjust your layout after it 
is completed. Follow these steps to ensure that your pages will be set up for Balfour standards.

1 Go to File > new > doCUMent… 

2 Adjust settings to match the example below using the correct Page Size. 
imporTaNT: It is crucial that 1p5 be entered into all bleed fields. If bleed and Slug are not available 
click on More options.

3 After entering the correct information you can choose to save these settings as a Preset. The advantage of 
saving these settings as a preset is that anytime you need to create a new document you can just choose 
the preset instead of entering all the information over again. Having a preset also minimizes the chances 
of pages being created in the wrong size.

4 Click Save Preset, name the preset and then click ok, otherwise click ok to close the window.

book siZe 7:

book siZe 8:

book siZe 9:

creaTiNg a NeW DocumeNT
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Once a new document has been created, you can specify where to start page numbering.

InDesign starts new documents at page 1 by default. Changing the starting page number will allow InDesign to 
properly number the other pages automatically.

The quickest and easiest way of  changing the page numbering in a layout is:

1 Select window > PaGeS or click on the Pages palette. 

2 Double-click the upsidedown triangle directly above the first page icon as shown below. 
 

3 The numbering & Section options window will appear. 
Click Start Page numbering at: and enter the desired 
page number.

4 After entering the desired page number click ok to 
apply the changes and close the options window. 
 

5 The Pages palette will automatically update all pages to the new numbering.

Notice that in this example, the pages have become a spread due to changing the starting page number to an 
even number.

Click the arrow to bring up the 
Numbering & Section Options

reNumberiNg a DocumeNT
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auTomaTic page Numbers
Automatic page numbers allow you to move, delete, or re-number pages within a document and have the page 
numbers update themselves to reflect the new changes instantly.  Follow the instructions below to insert auto-
matic page numbers onto a page.

1 First, create a text box using the text tool or frame tool.

2 Once created, select it using the text tool so that the cusrsor is blinking within its area.

3 Next, select the menu item tyPe > inSert SPeCial CharaCter > MarkerS > CUrrent PaGe nUbMer. 
Command+option+Shift+n  (on Mac) or alt+Ctrl+Shift+n  (on Windows) 

4 The current page number will now be displayed in the selected text frame. If the page is moved or 
re-numbered the text frame with the auto page number will automatically update to the new page number 
instantly.

NoTe: If  creating an automatic page number on a master page, a letter will be displayed in the text frame 
instead of  a page number.  This is normal, as the master page’s number is designated with a letter instead of  a 
number.  The proper page number will display on the pages.
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Master pages are used to apply the same design elements on all pages within a document. 

The advantage of  using a master page is that the elements created on it will be applied to every page in the exact 
same location, without having to duplicate work individaully on each page.  And, if  any changes are made, they 
are automatically made on every page to which that master page was applied.

Page numbering, folios, and backgrounds are some of  the most common items that take advantage of  the master 
page.

Follow the steps below to create items on the master page.

1 Double-click the a-Master from the Pages panel (below).

2 Once on the a-Master page, any design created will be applied to all “A” pages within the document. To 
return to your document’s actual pages, double-click the page you would like to go to from the pages in 
the lower half of the Pages panel.

NoTe: Objects created on the master page will only be selectable on the master page — you will need to return 
to the master page to make changes. 

If new pages are added, you can apply the master page to them by dragging the page onto the new page in the 
Pages panel, or by right-clicking the page in the Pages panel and choosing aPPly MaSter to PaGeS… from the 
contextual menu.

masTer pages

Double-click to 
access A-Master.

The tiny “A” indicates 
that A-Master has 
been applied to this 
page.

Master Pages

regular document Pages
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Object in InDesign can be placed on different invisible layers.  Each layer acts like a transparent sheet on which 
all of  that layer’s objects sit.

In InDesign, layers are convenient for working with overlapping objects, especially in situations where isolating 
certain types of  objects can make it easier to work with them.  Layers can be hidden, locked, and moved up or 
down in the “stack.”

On the layers panel, you can see and create new layers.  Every InDesign document must have at least one layer, 
but you can add many more above or below that initial layer 1.  Double-clicking a layer will enable you to set 
options for that layer, including a custom name, and color.  When selected, frames are shown with a color that 
matches the color set for the layer the frame is on.

The “stack” of  layers can be re-ordered top to bottom by dragging their names up and down in the list on the 
Layers panel.  The document is formed by stacking the layers in the order shown in the Layers panel.  Imagine 
that the layers are transparent sheets, and that you are looking down on the stack from the top, through to the 
bottom.

One of  the best uses for a layer is for a large backdrop or background image. When large image files are placed 
in a layout, it can dramaticly decrease the performance and speed at which the layout can be edited. If  the 
backdrop or background is on its own layer, you can simply turn off  the visibility of  that layer, thus hiding the 
backdrop and increasing the speed at which the layout can be manipulated. When done, turn the layer back on.

Locking background layers can also be very useful, so that you don’t accidentally click objects in the background 
or move them once you’re happy with them, and just trying to work with other objects on other layers.

layers

Indicates which layer is selected 
for editing.

Toggle a layer’s visibility by 
clicking the eye icon or the 
empty space in that column.

Lock a layer or unlock it by 
clicking the lock icon or the 
empty space in that column. 
When a layer is locked, none 
of  the objects on that layer 
are selectable, so they can’t be 
moved or deleted accidentally.

This special handle lights up 
when an object is selected — 
drag it up or down to move the 
selected object to a new layer.

Create a new layer.
Delete the highlighted layer.

Tip! Click the disclosure triangle in front of  any layer’s name to see a selectable list of  all of  the objects on that layer.
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To contine a story from one text frame to another, click the exit point on the first text box and then, click the 
entry point on the second one, or use the cursor to draw a new text frame.  This establishes a text thread between 
the two frames.  Text will now automatically flow between the boxes.

If  there is more text beyond what is shown in a text box, the exit point will turn red, and display a red 
plus mark.  Click this mark to create a new thread to place the remaining text in another text box.

Solum que culpa sitiisitio endit 
es ellam quame illupta volestem 
volut et doluptaest lantur ma quiam, 
cum re reprat aut qui saerciis et ad 
ut harum vitae nonsecus aliquia derit 
Quidisim porecta tiurio. Ellabo. 

Ut aut pore susae corion nis 
venditi orrovit, quia etusto volupta 
vent inverei ctorit que excea num 
venim aut estium 

Sedia consequam dolorem 
porenis modiani hitatectem vel ius 
magnihi llorroreius eum, qui nust, et 

Solum que culpa 
sitiisitio endit es ellam 
quame illupta volestem 
volut et doluptaest 
lantur ma quiam, 
cum re reprat aut qui 
saerciis et ad ut harum 
vitae nonsecus aliquia 
derit Quidisim porecta 
tiurio. Ellabo. 

Ut aut pore susae 
corion nis venditi orro-
vit, quia etusto volupta 

vent inverei ctorit que 
excea num venim aut 
estium 

Sedia consequam 
dolorem porenis 
modiani hitatectem vel 
ius magnihi llorroreius 
eum, qui nust, et ma 
dolores aut eum eost 
listem et as 

dolupta non pedig-
niet quam et autest, 
sit il ipsam inullabore 

Solum que 
culpa sitiisitio 
endit es ellam 
quame illupta 
volestem volut 
et doluptaest 
lantur ma 
quiam, cum 
re reprat aut 
qui saerciis et 
ad ut harum 
vitae nonse-
cus aliquia 

derit Quidisim 
porecta tiurio. 
Ellabo. 

Ut aut pore 
susae corion 
nis venditi or-
rovit, quia 
etusto volupta 
vent inverei 
ctorit que ex-
cea num venim 
aut estium 

Sedia 

consequam 
dolorem pore-
nis modiani 
hitatectem 
vel ius mag-
nihi llorroreius 
eum, qui nust, 
et ma dolores 
aut eum eost 
listem et as 

dolupta 
non pedigniet 
quam et autest, 

The type tool allows you to work with text in multiple ways on a layout.

The Type tool is located on the toolbar, and can be quickly selected by pressing t  
when you are not currently typing in a text box.  Clicking and holding on the type 
tool will open the submenu, where the type on a Path tool can be selected.

With the type tool selected, click and drag to create a text box.

Selecting any empty frame with the type tool will automatically change that frame to a text frame, so be careful 
where you click!

Use the column 
adjustment in the 
Control Panel to 
change the number 
of  columns.  You can 
change at any time.

Set a fixed column width in objeCt > teXt FraMe 
oPtionS… to automatically set the number of  
columns based on the width of  the frame.

To import text from another 

document, choose File > PlaCe… 
Command+d  (on Mac) or 

Ctrl+d  (on Windows) 

The Type Tool

click
andD r a g

exit Point

entry Point Arrows will appear in the 
exit points and entry points 
to indicate the flow of  text 
from one frame to another.

To see a blue line repre-
senting each text thread, 
choose View > eXtraS > 
Show teXt threadS.

CS6
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The type on a Path tool is used to type on lines or the perimeter of  objects. 

Selecting a line will allow the text to follow the contours of  that line. 

For the example below, a stroke color and thickness was added to the line, but you can 
create a line or object with no fill or stroke so that only the type is visible.

After typing on a path, you can select the line or object with a selection tool to adjust 
the handles as shown to position the start and end of  the text.  Text on a path also has 
entry points and exit points, just like any other text frame.

1  Create a shape using the pen, pencil, line, or frame tools.

2 Select the type on a Path tool in the submenu “under” the type tool

3 Move the I-beam cursor over the path that you would like to put the text on.  When you are over an 
acceptable path, a tiny + symbol will appear next to the I-beam:

4 Type, place, or paste the text you would like, and edit its font, 
size, etc., as desired.

5 You can use the handles to slide the start and end points along the path.

6 Open tyPe > tyPe on a Path > oPtionS… to set effects such as Skew or 3D 
Ribbon, if desired.

Type oN a paTh

Here
 is some text that follows an unusual path

 sh
ap

e.  
This is Type on a Path.

• T
hi

s i
s also Type on a Path, but the circle it rests on has n

o fi
ll 

or
 s

tr
ok

e!

yoU Can Make SoMe iMPreSSiVe eFFeCtS thiS way!

text

Start Point end Point
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InDesign can work with any of  the fonts that are installed on your computer.  To add new fonts, you must add 
the font files to the Mac or Windows operating system you are working with, and then re-launch InDesign to 
begin using them.  If  you are using a shared or lab computer, you may need an IT Administrator to add the 
fonts for you.  See the documentation or help files for your operating system for specific installation instructions.

WorkiNg WiTh FoNTs

replaciNg a FoNT
To replace a font throughout a document (even if  the original font is missing), 
follow these steps:

1 Choose File > PaCkaGe… and select the Fonts item in 
the left column.

2 Click the Find Font… button. The Find Font window 
will appear.

3 Select the font to replace from the list and then set the  
font to replace with as shown.

4 Click ChanGe all to replace the selected font on the 
entire layout.

5 Click done and then CanCel to exit the Package 
dialog box and return to the layout.

missiNg FoNTs
Upon opening a layout, if  the font files necessary 
for the document can’t be found, InDesign will 
warn you, and give you the choice to Find Font or click ok to skip the warning.

Choosing Find Font will open the Find Font window as pictured above. Follow 
the same steps for replacing a Font as described above to replace any missing 
fonts in a layout.

Choosing ok will not replace the font. Any missing fonts will be highlighted  
in pink on a layout in Normal View.

imporTaNT! You must replace these missing fonts or install the font files before 
printing or making a PDF, or the text will not print as expected.
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Type styles allow a user to create presets of  font and paragraph settings to quickly apply to text on a layout.  For 
example, you might create a style for your headlines, and a style for your body text, and then apply them to the 
corresponding text.  This will ensure that everything is consistent throughout your document and your book.

If  you later decide to make changes to the way a certain kind of  text looks, you can simply edit the style defini-
tion for that kind of  text, and all text with that style will automatically be updated. Styles can be saved and 
loaded, so they can easily be copied from one InDesign document to another, and can also be embeded into 
templates for standardizing settings.

Type styles come in two kinds: Paragraph Styles, which apply to entire paragraphs, and Character Styles, which 
apply only to the individual letters, numbers, and symbols (characters) selected.

characTer sTyles
Character Styles are a collection of  formatting attributes that can be applied to text in a single step.

1 To access the Character Styles panel, select it in the menu window > 
StyleS > CharaCter StyleS or press  Command+Shift+F11  (on Mac) 

or Shift+F11  (on Windows).

2 To create a new character style, click the icon at the bottom of the 
panel.

3 To veiw the Character Style options window, double-click a style on the 
Character Style palette. The Character Style Options Window allows 
you to define basic character formats, character color, and advanced 
type options.

4 After defining the options, click 
ok to save them.

5 To apply a character style, select 
the desired text and then click the 
desired character style to apply the 
preset format instantly. 

Character styles can also be imported 
from another document by clicking 
on the fly-out menu on the Character 
Styles panel, choosing load CharaCter 
StyleS… and then selecting the docu-
ment with the desired styles.

usiNg sTyles

Fly-out 
menu

Create a new Style

Current Style
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paragraph sTyles
Paragraph Styles include both character and paragraph formatting attributes, and 
can be applied to a paragraph or range of  paragraphs.  Unlike character styles, 
there is no need to highlight the entire paragraph to apply a style — the style will 
apply to whichever paragraph your cursor is currently in.

1 To access the Paragraph Styles panel, select it in the menu window > StyleS 
> ParaGraPh StyleS or press  Command+F11  (on Mac) or F11  (on 
Windows).

2 Creating a new paragraph style is the same as creating a new character style 
— just click the appropriate icon at the bottom of the panel.

3 To veiw the Paragraph Style options window as pictured below, double-
click a style on the Paragraph Style palette. The Paragraph Style Options 
Window will allow you to define basic formats, color, and advanced type 
options along with paragraph settings, drop caps, and other advanced 
paragraph settings.

4 After defining the options, click ok to save them.

5 To apply a paragraph style, select the desired paragraphs (or just place your cursor in the paragraph, for a 
single paragraph), and then click the desired paragraph style in the panel to apply the format instantly. 

Paragraph styles can also be imported from another document by clicking on the fly-out menu on the top right 
corner of  the Paragraph Styles panel, choosing load ParaGraPh StyleS… and then selecting the document 
with the desired styles.

new

Clear Style

Tip! To load all of  the type styles from another document (including both the paragraph and the character styles), 
choose load all teXt StyleS… from either panel’s fly-out menu.

Current Style
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aDvaNceD TexT TechNiques

creaTe ouTliNes
Creating outlines converts text into a vector graphic. This means that the individual characters (letters, numbers, 
symbols) are no longer text, but are actually drawings. This allows you to manipulate the individual shapes of  
each character, as if  they were lines drawn by the pen, pencil, or line tools.

imporTaNT! Once text is converted to outlines it can not be edited by the text tools any more.

1 Select the desired text and then choose the menu option tyPe > Create oUtlineS. 

2 Modify the text using the Direct Selection Tool (white arrow), just as if each letter were its own graphics 
frame.  One use for this feature is placing an image inside of  a word that has been converted to outlines.

Once a character is converted to outlines, each individual point on that character can 
be manipulated using the Direct Selection Tool, allowing you to distort or even create 
a whole new look from the original.

NoTe: Creating outlines removes the need for the actual font file. If  you need to 
make sure desired text does not change when viewed on different computers that may 
or may not have the same fonts as yours, you could create outlines of  the desired text, 
making it a graphic and no longer dependent on the actual font files.

cauTioN! Be careful when converting large bodies of  text to outlines — once it has 

Fill WiTh placeholDer TexT
Oftentimes, when creating brand new layouts, a designer would like to 
test a layout before all of  the text is ready.  In order to get a sense of  how 
a layout or part of  a layout will look with text in it, designers will use 
‘gibberish’ Latin text as a placeholder until the actual text is available 
(sometimes called “lorem ipsum text,” after the first two words of  the 
traditional set of  Latin phrases used by designers for decades).

InDesign can automatically generate appropriate placeholder text for 
this purpose.  In any text frame, simply right-click and choose Fill 
with PlaCeholder teXt from the contextual menu, or choose from the 
main menus tyPe > Fill with PlaCeholder teXt. InDesign will fill the 
remaining space in the text frame with random Latin.

Why Latin? The Latin gibberish mimics the look of  English words, 
sentences, and paragraphs, so the text ‘flows’ more realistically.  Also, if  
you forget having inserted the placeholder text, spell check should catch 
any leftover Latin words on the layout before they go to print.

Ad mo bla audit es mi, uta eium sundam 
lat officia quosam aut ium que nus diti 
comniendant libus sed magnim et ipsaecatur 
molenias evel iume voluptat ut facest laut 
maiossit estrupt aturem aliquibus plitae 
seniscilit, alibusa pienitiis dolorest, unt.

Beatur, sandemquam ese por alis 
dem. Molut odi od maximus re pedi tet 
faccum nimossum estrum as mod quatum 
quodi duntores accae cuptia vellectemque 
pratemque eossum isim aut facia dolor-
rore iliam voluptatur? Lorero volupti ssinit 
aperore riaepudite a velliciis exernate pa id 
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Placing images into a layout can be done in several ways. Acceptable image types for Balfour pages are jPeG, 
tiFF, and ePS.

To place an image, you can either create an appropriate graphics frame first, or create one as you place the 
image.

1 Choose File > PlaCe… or press the shortcut Command+d  (on Mac) or Ctrl+d  (on Windows)

2 Select the desired image or images — use the Shift  or option  ( alt  on Windows) to select 
more than one image, and then click oPen.  If an empty frame was selected before you chose File > 
PlaCe…, the image will appear in your frame, and you can skip the remaining steps.

3 If you did not select an empty frame before choosing File 
> PlaCe…, your cursor will change to a “loaded” cursor, 
with a thumnail version of the image ready to be placed.  If 
you chose more than one image, a number will be shown 
in parentheses, indicating how many images are currently 
“loaded” into the cursor.  Use the arrow keys on the keyboard 
to change which image is ready to be placed.

4 To place an image into an empty frame, click that frame. To 

replace an image already in a frame, hold down option  
(on Mac) or alt  (on Windows) while clicking it.  To place the image in a brand new frame, click and 
drag to draw a frame, or just click to create a frame as large as image at 100% size.

When placing an image into a frame, the picture might be larger or smaller than the frame itself. Fitting options 
allow you to either fit the image to the frame or fit the frame to the image. To access fitting options select an 
image frame and open the menu item objeCt > FittinG and choose the desired option, or use the tools on the 
Control Bar:

images

Tip! If  you are working on a slower computer, it is a good idea to crop images to the size of  the target frame 
before placing the image into InDesign. This creates smaller file sizes and increase the performance of  the 
layout when being edited. For example, if  the target picture frame were 4 in. x 6 in. and the image being placed 
into that frame were 40 in. x 60 in. It would take a lot of  computational power to manipulate the image.  If  it is 
cropped down to 4 in. x 6 in. before placing, it will drasticly decrease the file size and will allow the layout to be 
edited more quickly.

Fit frame to contentFit all content proportionally
Fit content to frame*

*cauTioN! The fit content to frame tool can distort photos!

Center content 
within the frame

Fill the whole frame 
proportionally

Click here to have InDesign 
automatically maintain the fit, 
even if  the frame changes.
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When working with text and photos/graphics on the same page, there are often situations where it would be 
convenient or aesthetically pleasing for a space to be left in the body of  text around an image.  Text wrap allows 
you to force text to “wrap” around a frame with an image in it (or even more text).

1 Place an image on a layout with text.

2 Move the frame with the image over the text frame, so that 
they overlap.

3 Open the text wrap panel from window > teXt wraP menu 
item, if it is not already open.

4 Click the appropriate wrap style at the top 
of the panel, and set how far away the text 
should be kept below. 

image Wrap

Vid et denient volorero dolupis aut 
vellabo. Itatemp oritaspis derrovidi 
sum volora cum sin nus.

Dolo illecte eum laborrorem 
volorerum laudam apis as magni que 

sandiore num enihillendit quatem 
hicimpore nostem et ut ditatiis 
errovidebis et, in ende lab iligend 
andandi geniminciam ressit que rat.

Catem que int od maiost of-
ficiatur, con nimenimil estrum quis 
nihilibusam et fugia dolorem que simi, 
omnis ipsunt quaspelest dent eseque 
sequasintis aborae non consequo te 
consed quam is et que doluptus, vid 
mincta consequam, sequi vidis eatia 

volo volo dem re aut destiunt 
et, sitibus apient.

Bis iduci remquiae dolupta-
tusti oditius trumquam rehent.

Bea dolest volorem volupta 
perero cus.

Vid ullatur, sitis mil-
landundi quam rehenis dem 
repelectem harum repro 
eniende stiscid eliquo conemo 
et inciet lam, sed quas dis 

Vid et denient volorero dolupis aut 
vellabo. Itatemp oritaspis derrovidi 
sum volora cum sin nus.

Dolo illecte eum laborrorem volore-
rum laudam 
apis as 
magni 
que 
sand-
iore 

num enihillendit quatem hicimpore 
nostem et ut ditatiis errovidebis et, in 
ende lab iligend andandi geniminciam 
ressit que rat.

Catem que int od maiost officiatur, 
con nimenimil estrum quis nihilibus-
am et fugia dolorem que simi, omnis 
ipsunt quaspelest dent eseque se-

quasintis aborae 
non consequo 
te consed quam 

is et que dolup-
tus, vid mincta 

consequam, sequi 
vidis eatia volo volo 

dem re aut destiunt et, 
sitibus apient.

Bis iduci remquiae do-
luptatusti oditius trumquam 

rehent.
Bea dolest volorem volupta 

perero cus.
Vid ullatur, sitis millandundi quam 

rehenis dem repelectem harum 
repro eniende stiscid eliquo 

Vid et denient volorero dolupis aut 
vellabo. Itatemp oritaspis derrovidi 
sum volora cum sin nus.

Dolo illecte eum laborrorem volore-

rum laudam apis as magni que sandio-
re num enihillendit quatem hicimpore 
nostem et ut ditatiis errovidebis et, in 
ende lab iligend andandi geniminciam 

ressit que rat.
Catem que int od maiost of-

ficiatur, con nimenimil estrum quis 
nihilibusam et fugia dolorem que simi, 

omnis ipsunt quaspelest dent eseque 
sequasintis aborae non consequo te 
consed quam is et que doluptus, vid 
mincta consequam, sequi vidis eatia 

Vid 
et 
de-
nient 
vol-
orero 
dolu-
pis aut 
vel-
labo. 

Itatemp oritaspis derrovidi sum volora 
cum sin nus.

Dolo illecte eum laborrorem 
volorerum laudam apis as magni que 
sandiore num enihillendit quatem 
hicimpore nostem et ut ditatiis 
errovidebis et, in ende lab iligend 
andandi geniminciam ressit que rat.

Catem que int od maiost officiatur, 
con nimenimil estrum quis nihilibus-
am et fugia dolorem que simi, omnis 

ipsunt quaspelest dent 
eseque sequasintis 
aborae non consequo 
te consed quam is 
et que doluptus, vid 
mincta consequam, 
sequi vidis eatia 
volo volo dem re aut 
destiunt et, sitibus 
apient.

Bis iduci remquiae 
doluptatusti oditius trumquam rehent.

Bea dolest volorem volupta 
perero cus.

Vid ullatur, sitis millandundi quam 
rehenis dem repelectem harum repro 
eniende stiscid eliquo conemo et inciet 
lam, sed quas dis sum hicitat quis mag-
nist et in est, tempore cepudio blaceat 
ectatiore verum, odit ulparci

wrap around 
bounding box

wrap around 
object shape

jump object

jump to 
next column

no wrap

Vid et denient volorero dolupis aut 
vellabo. Itatemp oritaspis derrovidi 
sum volora cum sin nus.

Dolo illecte eum laborrorem 
volorerum laudam apis as magni que 
sandiore num enihillendit quatem 
hicimpore nostem et ut ditatiis 
errovidebis et, in ende lab iligend 
andandi geniminciam ressit que rat.

Catem que int od maiost of-
ficiatur, con nimenimil estrum quis 
nihilibusam et fugia dolorem que simi, 
omnis ipsunt quaspelest dent eseque 
sequasintis aborae non consequo te 
consed quam is et que doluptus, vid 
mincta consequam, sequi vidis eatia 
volo volo dem re aut destiunt et, 
sitibus apient.

Bis iduci remquiae doluptatusti 
oditius trumquam rehent.

Bea dolest volorem volupta perero 
cus.

Vid ullatur, sitis millandundi quam 
rehenis dem repelectem harum repro 
eniende stiscid eliquo conemo et inciet 
lam, sed quas dis sum hicitat quis mag-
nist et in est, tempore cepudio blaceat 
ectatiore verum, odit ulparci

Ra venime sum harum quam 
nis ea nos soluptatur, qui underiae 
core nis plique voluptaquo te provit 
estota dolupti aeribus, core pro et qui 
omnihictest rae conse re consequi 
dolorectur aut adi cuptia que cullis ea-
quia volesciat dolupta quos dolorenda 
si unditecae qui quid et laboribus pos 
dolum quid qui te nus, nem endi as si 
doloruntiae rerunti atquam quibero 
officte nis audantur anto bercienimus 
nonet voluptate cus exped ut estiasi 
comniatem am velic temquas plandiae. 
Dus sequatur rehendit, odis expla 
veratiu mquam, si velent.

Umquo im nonem aspis dolorest

If  you have created a clipping path in 
Photoshop, you can select it using the 
type: option on the Text Wrap panel.
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The links panel displays all of  the images (and any other types of  file) that you have placed into this document 
— when you place an image, the image file stays on the disk, and InDesign simply looks up the image when 
needed.  Because of  this, any changes you make to a photo after you place it on the page will still be updated on 
the page.

The downside is, however, that if  you remove or move the original photo file, InDesign will no longer be able to 
find the file when it needs it.  This is called a missing or broken link.

imporTaNT! You must fix any broken links before printing or making a PDF, or your photos will be printed 
at a severely reduced quality.

liNkeD Files

one or more 
instances modified

Link modified; 
needs to be updated

Missing link

Show/hide 
link info

Relink file

Page number 
where link 
is located

Show in document

Update the placed image

Edit the original file

embedded link
(entire file saved 
inside the InDesign 
document)
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The effects panel offers a variety of  high-quality effects that can be 
applied to InDesign objects.  The effects are very similar to those 
available in Photoshop.  Each effect has an array of  parameters that 
can be set, to fine-tune the look of  the effect, and the effects can 
be layered.  The effects can also be selectively applied to the entire 
object, or just its stroke, fill, or text.

To apply an effect, simply select an object and click the “fx” icon at 
the bottom of  the Effects panel.

Here is a look at some effects that you may find useful:

eFFecTs

effects Menu

Set 
opacity

Drop shaDoW
Inner Shadow

ouTer gloW

Inner GLOW
Bevel and emBoss

Satin
Basic Feather

Directional Feather

Gradient 
Feather
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InDesign provides tools to rotate, skew, or scale any object on the page.  Together, these operations are called 
transformations.

The toolbar has a tool for each operation, as well as a Free Transform tool, which will let you perform any of  
the three, or more than one at a time.

InDesign also gives you the ability to rotate an object without selecting the rotation tool first. 
Simply select an object with the selection tool (black arrow), and then move the cursor just 
outside the boundaries of  the frame near any corner.  The cursor will change to a double-
pointed, bent arrow.  You can now click and drag to rotate the object!

You can also perform precise transformations by selecting an object and then altering the transformation values 
in the Control Bar:

TraNsFormaTioNs

Free transform tool  e  Rotate, scale, or shear

rotate tool  r  Rotate an object

Scale tool  S  Scale an object

Shear tool  o  Shear an object

Scale keep Proportional

rotate rotate 90º

Skew Flip horizontal/Vertical

This is a representation of  
the applied flips rotations.

Tip! The symbol at the left side of  the Control Bar (pictured at left) will allow you to set the 
Reference Point for the object you have selected. The reference point is the point that the object 
will pivot around when rotated, and where it will grow or shrink from when resizing. Click any 
one of  the nine points to set that as the reference point. The center is selected by default.
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You can set the color of  an object — its fill, stroke, or both — using the color tools located at the bottom of  the 
toolbar or the similar set of  color tools at the top of  the Swatches panel (window > Color > SwatCheS) or the 
tools on the Color panel (window > Color > Color). All of  the color tools work the same way and accomplish 
the same thing.

The Swatches panel allows you to save new swatches of  color to use and reuse, much like text styles.  Just like 
styles, altering a swatch will also change any object you’ve applied that swatch to.

Double-click any 
swatch to edit it.

Process

CMYK

Lab RGB

Mixed Ink

Spot 
(Danger! You have to purchase 
these when you print!)

colors aND sWaTches

 Swap fill color and outline color

 Current fill color (click to set)

 Current stroke (outline) color (click to set)

 Set the fill and 
stroke to defaults

 Select fill and stroke for frame/object

 Select fill and stroke for the text within

 Switch between selecting fill and strokeX

on the wide toolbar:

on the normal 
toolbar:

on the top of the 
Swatches Panel:

Sample Color

Currently Selected Color

Gradient Swatch

Color tools

registration Marks only

tint (lighten the color)

new Swatch

Color type & Mode:

on the 
Color Panel:

imporTaNT! Don’t select [registration] for anything. It looks black, but it won’t print!
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Fading from one color to another gradually is called a gradient.

You can create gradents by mixing colors on the Gradient panel.  You can even save gradients to the Swatches 
panel for easy re-use.

Gradients can be applied to fills, strokes, or both. 

Use the gradient tool on the toolbar to quickly set where a gradient begins and 
ends, and at what angle the gradient is set.

1 Select any object with a gradient.  Be sure that the fill or stroke is selected 
in the color panel or toolbar, depending on which you would like to 
change.

2 Click and drag the tool anywhere on the page to set the beginning, end, 
and angle of the gradient.  Most of the time, you will want to drag the line 
directly over your selected object, but you can drag the line totally outside 
of the object — experiment a bit to get a feel for how it works.  You can 
repeat the process to change the gradient over and over.

graDieNTs

Drag this sample 
to the Swatches 

panel to save it as 
a swatch.

Click anywhere else on the bottom of  
the gradient to establish a new set point

Click to select and set a 
new color; drag off  the 

bottom to delete

Slide to change where the midpoint 
between the two colors falls.  A 
new one is added between every 
color set point.

Click to select and set a 
new color; drag off  the 

bottom to delete

Gradient adjustment Center Point

reverse Gradient direction

Color set point Color set point
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The Stroke panel (window > Stroke) and the Control bar offer a variety of  useful options that can be set for lines 
in your layouts.

sTroke opTioNs

line thickness

Cap style (ends)

join style (corners)

Stroke type:

decorations on 
Start or end:Color in between 

dashes for dashed/
slashed/doubled styles

Draw the stroke centered across the border of  the 
object selected or on the inside or outside.

Straight, rounded, or projecting 
beyond the edge of  the line
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To keep things aligned, you can use InDesigns guides, grids, and smart guides.  
You can turn all of  them on or off, and turn on or off  “snapping” to the guides 
and grids in the submenu under View > GridS & GUideS.

griDs, guiDes, & aligNmeNT

guiDes
InDesign guides are visible in normal view mode (switch between normal and 
Preview mode, which shows only what will print by using the button at the 

bottom of  the Toolbar or by pressing w  when not in a text frame).

You can create as many guides as you would like by dragging down from the ruler at the top or by dragging to 
the right from the ruler on the left side of  the window.  Each guide is selectable and moveable, and can be set to 
a specific location by specifying the location in the Control Bar.

griDs
Grids are normally invisible lines that are preestablished and cover the entirety of  the page. Occasionally, it may 
be useful to display and/or snap objects to the Document Grid, a grid covering the entire page, or the Baseline 
Grid, which aligns with the baselines of  text on the page.

smarT guiDes
Smart guides are bright green and purple measurement lines that light up as you drag 
objects around, showing you when they are aligned with the edges or centers of  other 
objects.  Smart guides also indicate when you have an object evenly spaced from other 
items on the page.

aligNmeNT
Use the alignment tools on the Control bar or on the align Panel (window > objeCt & layoUt > aliGn) to quickly 
align objects.  Just select all of  the objects to be aligned, and click your preferred alignment.

align to:

left edge bottom edge

top edgeright edge
Vertical Centerhorizontal Center

Use these tools to 
distribute objects 
evenly, measuring 
from the marked 
edges.

Use these tools to 
distribute the space 
between objects evenly, 
rather than the objects 
themselves.

Use this drop-down to 
align objects to each other 

(“Selection”) or to page features like 
the margins, page, or spread. Use 
“Key Object” to select a single object 
to align others around (click to set; 
shown with a thicker border).

CS6
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TemplaTes & libraries
TemplaTes
To save time, you can save a document as a template to be used for other documents.

1 Set up your document exactly how you want it, including master pages, folios, margins, etc. 
that you will want to be a part of the template.

2 Select the menu item File > SaVe aS….

3 Name the template and set it to save in apropriate location.  Choose indesign CS6 template 
from the Format menu.

4 Click SaVe.  You can now open the template any time to start a new document that will 
match the template.

libraries
An other great time-saver is creating a library to hold frequently used bits of  layout. A library 
looks like a standard panel, but you can drag any piece or pieces of  layouts in, and they will be 
saved. You can then drag a copy of  the pieces out onto a layout whenever you need them.

1 Select the menu item File > new… > library….

2 Specify a name and location to save the library, and click SaVe.

3 Drag an object or many objects (hold Shift  to select more than one) over the library’s 
panel and drop it in to create a new entry.

4 Double-click the new entry to name it.

5 Drag a copy of your object(s) onto the layout.  Repeat whenever necessary.
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Top Tips
1

2

Change Spot Color to proCeSS

UnCover hidden folioS

Double-click the problem swatch

Select the folio, and 
drag the selector 
square up to a 
higher layer!

Don’t forget — you 
can use the eye 
icons to hide and 
show layers and 
make it easier to 
find things!
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3 find Color on a blaCk & white page
Rich black sometimes sneaks 
into layouts — that’s the kind 
of black made from all four 
inks, rather than just black.

Your process colors 
are formed by combining 
Cyan, Magenta, Yellow, 
and Black — Click the 
eye icons to toggle each 
color layer on or off 
to see what colors will 
print where to combine 
for your finished look.  
Rich black will show 
up on every seperation if 
it’s there.

Use the Seperations Preview 
to hunt it down!
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4 iS the photo in proportion?
Sometimes, photos just get 
distorted, but we don’t want any 
funhouse images in the year-
book.  Here’s how to check 
them:

Click the photo with the white 
arrow, to make sure the content 
is selected.

Check the dimensions in the 
control bar — if they don’t 
match, it’s distorted!

Highlight one dimension, and 
copy and paste it to the other.

There! That’s better!
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Rem qui que nulliquia is is eum quisciis doluptas dolo invendam voloriatia quam que cor sed ut repere, tempossim consecti consenesto beaquis 

magnimus eictatus dolor sed modi dolor autassus recabo. Nequas maxim audam et et utae soluptaquam il min et et prae places vende ne qui que inum 

ipicil magnatu riberita dolutatur sinulparum estis ut ma que corporem qui re, qui blaccaeptur atate doluptatur?

Ximpos ero que nobis undios explace rspeliquatis dolorerumqui dolorer chitatiis moloreh endenim olorepudicit voles et quiatem fugia nonsequam, 

occatem ene officienihic te autem unt estotat quaesent est eos solupta et volentius quunt fuga. Name eliatque accabore, ut aut occum eiumque eatur 

repeles abo. Pellaud ipsamenis di ut lam que vollaccum eosa quas aut earia si dolutem osandebis doluptium et, sit, ut est laut a corestium ipsum lit-

asperum voluptibus aut dolupta que volupta 
tectotati con porem hitet elictem autatemquis 

est, consend igende posaest, voleces ratem 
evellutem ut la cum fugitia eculpari iur magni-

modis ea dolecto rrunto idebis sapel idi aut 
eossendant.

Eraernatet fuga. Ita quia plique re con-
serem voluptibus aspitem volut magnis volumquae 

nihicit audi ius nonecus dolo denit remque 
autemoloraes evelibu sciendae magnihi tempor-

rum quia id quassequos ra dolupta coreris 
mostiae conemquiam que quam faccupta cust 

aut eos si dicab ipsum dolo dolo bea quia 
venditate cuptat.

Tur, officto que iunt eum voluptatis et aut 
experoriati que laut as ulligenditi sed quam que 

officae enis quam, cus ad eos et lacepe pori 
intusandem quisquis ducitis con nobitatus alicia 

quiae modio ipicim niasinture volor aut qui 
to volore eseditatet estorec epudite int doloritatem 

volupidi quatet abo. Nam faccaborem doles 
pos ut ditates ciisti que esto dolupti andipsum 

enis res volorio. Ut re nisinvel ipsam harum 
fugias dolupictati anti to int aci quam voluptatum 

aspis et eaque mo quiae velenduciur reici 
cum et aut estiassin es essequi optias dolore 

dolorepe adit atquias expedigni dolorrunt 
antesto ilitae. Faci tecerecea aut int, occaboratur 

minim ulpa voluptatat odis rae labor saes sin 
comnis sam id quia sam experfe raeperio ea eos 

aliquibusam serum harchil laccupt iuntur ad 
quia ipis vendame plitatenturi tem reheni arum ut 

ommod eatet mo vernat optatur? Ebitiam, 
sunt fuga. Et apitas restio beaquam repero dolupic 

te perferita di dolorem id quunti dolum 
et ilique labo. Nam, is maximendae omnime 

archicatem cuptasi nis et aliquo tor re sitas 
auteture recae niet, as aliquassenis ent que litatus 

autatiis eum que dipsaperis ide qui doles do-
luptat licia voluptur assequati volupta del incipicil 

molupta dolupta temolup tiundi con prae 
volorro omni que et volorrum fugias que erae enes 

am, ipsam corerovid ea conescia eosam solorum et eria quis eari odit as a sam qui bla cusandit et optaspel ipsam, suntem is et modi num quae volum 

lab ium nonseque rate plia venimus, quunt que voluptae dolore sandi offici dolenis accatemposam vellaciis a sum reritiam hariost, eos excerci urestia-

tur, utemolorem sendaep erspere nos est rerest restotatibus sa velendenis se nulla destis doluptiore volores doluptatus dolor aut magnam, venisquam, 

explam siminci dempor resto et volla cor aut ra evel eum nonsed quiat.

Ra is adipsunt. El is intis ute percimus aut aborest otatum faccus endel imusam, corere eatenis quia dolupti sim recusdam et reptat liquaep udipici-

tae sunt dit vendelluptae volor arum fugia doloria nempe volupid moloratur? Qui doluptatibus nobisciaes dis vel il milique natus.

Orrum se aut verovit atinciis impore demodia quae comnimi ncimagnita volor soluptatur?

5 name miSSing below wrapped photo

If a caption disappears from 
under a photo that has text 
wrap turned on, select the 
frame with the hidden text, and 
choose OBJECT > TEXT FRAME 
OPTIONS…

Choose Ignore Text Wrap, and 
it should come right back!
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6keep a CUtoUt, well, CUt oUt

A quick trip to OBJECT > 
CLIPPING PATH > OPTIONS 
will cure what ails ya!
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7 eaSy CUtoUtS
Here’s a quick overview of the 
steps to make a good cutout

Loosely select your subject 
in Photoshop — the Quick 
Selection Tool helps!

Create a new layer via cut

Delete the Background layer

Save as a PSD and Place in InDesign!
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8 fix type on a path diSappearanCe

Hey!  There was supposed to 
be type on this path!  How can 
we get it back?

Now, that’s more like it!

Click on the path with the black 
arrow, and then choose EDIT 
> EDIT IN STORY EDITOR to 
see if there actually is text

If there is, click on the line 
with the text tool and choose 
TYPE > PARAGRAPH.

Check to make sure there is no 
Drop Cap. If there is a Drop 
Cap, the text will not show. 
Put a zero there instead.

T
yp

in
g 

on
 a 

path is sure a great w
ay to spend the day

 —
 do

n’t
 yo

u ag
ree?
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9 QUiCkly Size a headline
So, you already know that you can 
quickly resize a photo or graphic by 
holding down Command+Shift  (on 
Mac) or Ctrl+Shift  (on Windows) 
(if not, see page 6) — but did you 
know it works for text, too?

Just type your headline…

Turns out, it’s a great time 
saver for finding the right size 
for a headline!

The Greatest Headline Ever Written

The Greatest Headline Ever Written

The Greatest Headline Ever Written

The Greatest Headline Ever Written
…then, be sure to ‘shore up’ 
your text box so it fits the 
text exactly — you can use the 
Fit Frame to Content tool, or 
double-click the lower right 
handle!

Then, click a handle with the black arrow, hold down 
Command+Shift  (on Mac) or Ctrl+Shift  (on Windows), 

and drag away!
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10 aUdition fontS

If you’ve got a lot of fonts, it can be hard to 
pick one for a headline.  There’s a quick way to 
try ‘em all out, though!

Type out the text of 
your headline, and then 
click the Selection 
Tool (the black 
arrow), then click the 
Text Tool.

Then click inside the Font field on the 
Control Bar

Then, just tap the Up and 
Down arrows on your keyboard 
to flip through the font 
possibilities, until you find one 
you love!

The Greatest Headline Ever 
Written

The Greatest Headline 
Ever Written

The Greatest Headline Ever 
Written

 
 

The Greatest 
Headline Ever 
Written

The Greatest Headline 
Ever Written

The Greatest Headline Ever 
Written

The Greatest Headline 
Ever Written

The Greatest Headline Ever 
WrittenThe Greatest 

Headline Ever 
Written
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We hope these top tips Will help 
your designs stay tip-top!

You can get lost in all of the 
guides, grids and boxes in the 
Normal View of InDesign.

Use the W key on the keyboard 
to flip back and forth between 
Normal mode and Preview mode 
periodically.

You’ll be surprised at what you 
catch!

11

W
SwitCh to preview mode
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This is a reference chart for all of  the tools on the standard toolbar. Shortcut keys are indicated 
like this , and key tools that you will most frequently use are highlighted like this.   

Detailed information on how to use most  
tools is available on other pages.

Toolbar quick reFereNce

Cut a frame or pen-line shape into pieces C   Scissors tool

Move the page around within the window h   hand tool
Zoom in or out of  the page view Z   Zoom tool

 Set the color of  fills and 
outlines for objects and text

 Swap fill color and outline color

 Current fill color

 Current stroke (outline) color

 Set the fill and stroke to defaults

 Select fill and stroke for frame

 Select fill and stroke for text

 Switch between selecting fill and stroke

 Toggle Modes

note tool  Make a non-printing note

Draw shapes point-to-point P   Pen tool

Applies last selected solid color ,   apply Color

Normal

Applies last selected gradient .   apply Gradient

Preview

Clear all color - make transparent /   apply none

Bleed

Slug

Presentation

 =   add anchor Point tool
 -   delete anchor Point tool

 Shift+C   Convert direction Point tool Pencil tool  n  Draw a line freehand

eyedropper tool  i  Pick up an object’s characteristics

Measure tool  k  Measure distances on the page

Fill/outline Settings

Change View Mode

Smooth tool  Simplify a drawn line

erase tool  Erase segments of  a drawn line

Move the entire page Shift+P   Page tool

X

w

CS6
Dynamically resize objects to alter the gap U   Gap tool

 b   Content Collector tool

Change how a gradient flows G   Gradient Swatch tool

 Shift+G   Gradient Feather tool
Make an object fade away in one direction

line tool \   Draw Straight lines

Draw an empty frame F   rectangle Frame tool
Draw an empty frame  ellipse Frame tool

Draw an empty frame  Polygon Frame tool

Selection tool  V  esc  Select objects

type tool  t  Select or edit text

rectangle tool  M  Draw a filled rectangle

Free transform tool  e  Rotate, scale, or shear

rotate tool  r  Rotate an object

Scale tool  S  Scale an object

Shear tool  o  Shear an object

ellipse tool  l  Draw a filled ellipse

Polygon tool  Draw a filled polygon

type on a Path tool Shift+t   Select and edit 
text on an unusual shape

direct Selection tool  a  Select content or 
edit frame shapes

Collect pieces of  layouts to link and reuse elsewhere
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iNDex
3D ribbon  14

a
add anchor point tool  39
add new fonts  15
alignment  27
application frame  3
apply color  4, 39
apply gradient  4, 39
apply none  4, 39
arrows  

direct selection arrow (white arrow)  
4, 7, 39

selection arrow (black arrow)  4, 7, 39
automatic page numbers  10

b
background  11, 12
basic feather  22
bevel and emboss  22
bleed  3, 8, 39
book size  8
broken links  21

c
cap style  26
center content within the frame  19
change view mode  4, 39
character styles  16
clipping path  33
color  24, 29, 30
color tools  24
content grabber  7
content collection tool  39
control bar  3
convert direction point tool  39
create outlines  18
creating a new document  8
crop images  19
current stroke (outline) color  4, 39
cut out  33, 34
cutout  33, 34

D
delete anchor point tool  39
direct selection tool  see arrows
directional feather  22
distorted  31
document  3
drop shadow  22

e
effects  22
ellipse frame tool  4, 6, 7, 14, 39
ellipse tool  4, 39
embedded link  21
end point  14
entry point  6, 13, 14
erase tool  39
essentials  3
exit point  6, 13, 14
eyedropper tool  39

F
fill/outline settings  4, 39
fill the whole frame proportionally  19
fill with placeholder text  18
find font  15
fit all content proportionally  19
fit content to frame  19
fit frame to content  19, 36
fitting options  19
flip  23
folios  11
fonts  15, 37
frames

graphics  6, 7, 14
text  6, 7, 13, 14

frame tools  13, 14
free transform tool  4, 23, 39
fx  22

g
gap tool  4, 39
gradient feather  22
gradient feather tool  4, 22, 39
gradients  25
gradient swatch tool  4, 39
grids  27
guides  27

h
handles  6
hand tool  4, 5, 39
headline  36
hidden folios  29
highlighted in pink  15

i
I-beam cursor  14
ignore text wrap  32

images  19
image types  19
image wrap  20, 32
import text  13
inner glow  22
inner shadow  22

k
keep proportional  6, 7, 23, 31, 36

l
layers  12
libraries  28
line thickness  26
line tool  4, 14, 39
linked files  21
links  21
live screen drawing  5

m
margin  3
master pages  11
measure tool  39
missing  32
missing fonts  15
mouse  5

N
normal  39
note tool  39
numbering & section options  9

o
opacity  22
outer glow  22
overlapping  12

p
page  3, 9, 11
page number  9
page tool  39
panels  3

docking  3
paragraph styles  16, 17
pasteboard  3
path, type on a  35
pencil tool  4, 14, 39
pen tool  4, 14, 39
place  13, 19, 21
placeholder text  18
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polygon frame tool  4, 6, 7, 14, 39
polygon tool  4, 39
presentation mode  39
preview mode  38, 39
process color  29
proportion  6, 7, 23, 31, 36

r
rectangle frame tool  4, 6, 7, 14, 39
rectangle tool  4, 39
red plus mark  13
reference point  23
registration marks  24
relink  21
renumbering a document  9
replacing a font  15
resize  6, 7, 36

from the center  7
rich black  30
rotate  23
rotate tool  4, 23, 39

s
satin  22
save preset  8
scale  23
scale tool  4, 23, 39
scissors tool  39
select fill and stroke  4, 39
selections  7
selection tool  see arrows
seperations preview  30
set the fill and stroke  4, 39
shear tool  4, 23, 39
shortcuts  4
size  6, 7, 36
skew  14, 23
slug  39
smart guides  27
smooth tool  39
spot color  29
stack  12
start point  14
stroke  26
stroke options  26
styles  16
submenu  4
swap fill color and outline color  4, 39
swatches  24
switch between selecting fill and stroke  

4, 39

T
templates  28
text frame  13
text thread  13
text wrap  20
text wrap  20, 32
thread  13
tint  24
toggle modes  39
tool, add anchor point  39
toolbar  3, 4
toolbar  39
toolbar, main  4
tool

convert direction point  39
delete anchor point  39
direct selection  see arrows
ellipse  4, 39
ellipse frame  4, 6, 7, 14, 39
erase  39
eyedropper  39
free transform  4, 23, 39
gap  4, 39
gradient feather  4, 39
gradient swatch  4, 39
hand  4, 5, 39
line  4, 39
measure  39
note  39
pen  4, 14, 39
pencil  4, 14, 39
polygon  4, 39
polygon frame  4, 6, 7, 14, 39
rectangle  4, 39
rectangle frame  4, 6, 7, 14, 39
rotate  4, 23, 39
scale  4, 23, 39
scissors  39
selection  see arrows
shear  4, 23, 39
smooth  39
type  4, 39
type on a path  4, 39
zoom  4, 5, 39

transformations  23
type on a path tool  4, 14, 39
type on a path tool  13
type tool  4, 13, 39

v
view  5

W
window  3
w key  38
wrap  20, 32
workspace  3

Z
zoom tool  4, 5, 39


